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Chapter 1. Introduction
Thank you for purchasing PA966.

Your PA966 is a rugged, compact and lightweight palm-size computer. It utilizes the
Windows CE operating system, and incorporates two optional scanning laser device, laser
& imager, color LCD with touch screen, keypad, and wireless communication capability.

It provides the user with a standard Windows-based environment for customizing and
operating the device.

This PA966 product reference guide will guide you to access your PA966.

Unitech PA966 and Unitech PA967

PA967 is PA966 with add-on gun grip for more convenient barcode scanning.

This user manual is shared and used by the series below:

PA966BTG- terminal with bluetooth utility only.
PA967BTG- PA966 terminal with bluetooth and 802.11g and with add-on
gun grip for more convenient barcode scanning.

and 802.11g
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NOTICE
This unit is equipped with a battery pack and backup battery. It is possible that the Unitech PA966 may
not powered on due to battery discharge as a result of storage.

In the above situation, plug the PA966 to the USB cable with DC in port or put the unit
into the Unitech PA96x Cradle (with 12V/2A AC-DC adapter), and recharge the unit for 16 hours in order to
fully charge its backup battery.

The backup battery will charge from external power or the main battery (if the main battery still has
enough power to turn on). In the event the main battery is fully charged, refrain from using the PA966 for
16 hours in order for the main battery to fully charge the backup battery.

Backing up data by backup battery only, without the main battery installed in battery compartment may
take as long as 6 hours. Therefore, in order to prevent data protection failure due to backup battery failure,
do not leave the PA966 without the rechargeable battery pack installed, or without connection to AC
power for an extended period of time.

ۖ

Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one of the
following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

This device and its antenna(s) must not be co-located or operating in conjunction with any other
antenna or transmitter.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. This equipment should be installed and operated with minimum distance 20cm
between the radiator & your body.
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Stylus

Pulling-tags RF Card Cushion

PA966 CDPA966 Main Body

Battery pack

CF slot drawer for PA966

Unitech PA966 & Accessories
After opening the box, please make sure the
following accessories for the PA966 are present:

Quick Reference Guide
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Tour of the Unitech PA966

Stylus
This stylus is designed for tapping
screen .

Touch Screen

USB/
Charging Port

Scanner

Right Side Scanner Trigger
Press it to enable scanner to
read bar code.

Keypad

PA966 Back

IrDA port

Reset Hole
Push enclosed button for system
warm-start

CF slot compartment
Please remove the battery door to
access CF slot.

PCMCIA compartment
Install PC card here.

Battery compartment
Install Lithium-ion battery
pack here.
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First Steps with the Unitech PA966

:

NOTE: Data you entered may not be properly stored until the built-in backup battery has
been adequately charged. Please remember to turn on the back up battery before you
charge the terminal.

Installing the Battery Pack

1.Remove the battery compartment door (located on
the lower back side of the unit).

2.Position the battery pack with the label side towards you, and the
battery pack strap towards the bottom of the unit. Insert and fully seat
the battery pack, making sure the shape of the battery pack fits the
shape of the battery compartment.

Docking Station
USB/Charging cable
Rechargeable Lithium-Ion battery pack
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Or place the PA966 into the Docking Station
(first connect the power supply to the Docking
Station).

Connect the RS232/Charging Cable or USB/
Charging Cable to the PA966, and then
connect the AC adapter to the cable’s power
jack and an electrical outlet.

Supplying Power to the PA966

3.Position  the battery pack and install the battery
compartment door.

Charging the Main and Backup Batteries for the First Time
It may take up to 16 hours to fully charge the empty backup battery. The first time charge should
be at least 16 hours to ensure a proper charge.

CAUTION:  Operating the PA966 for the first time without the AC adapter, and without fully
charging the backup battery may result in loss of data stored in RAM memory.

ۖ
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If a PCMCIA card is inserted into the PA966 without previ-
ously attaching a Pulling Tag, the card can be removed by
affixing a length of adhesive tape to the surface of the card
and pulling the card out by pulling outward on the piece of
tape.

PCMCIA Pulling Tags

Pulling Tags simplify the removal of PCMCIA cards from the PA966. Before
inserting a PCMCIA card, remove one of the three Pulling Tags from the
Pulling Tag sheet and adhere it to both sides of the PCMCIA card, leaving a
short (approx. ½”) tab. To remove the PCMCIA card, simply pull outwards on
this tab.

Protective Screen Film

The PA966 screen ships with a protective plastic film. You may remove this if desired by
peeling from one corner. The screen will be more susceptible to scratching without the
film, but will be more readable.

Using the Stylus

CAUTION: Never use anything other than the PA966’s stylus on the
screen. Using object other than a stylus could cause permanent
damage.

To write data into a field on a form, use the stylus to print the letters or
numbers. Use very light pressure.

3.

To make a choice from a menu, lightly tap the tip of the stylus on that
choice.

2.

Hold the stylus as you hold a pencil.1.

Front side of PCMCIA card
Insert CF card to PA966

Find the CF drawer from PA966 package, insert CF card to the
CF drawer. Then insert the CF drawer to the PA966 and place
the CF slot door. Re-install the battery door to PA966.

1. 3.2.

Your CF card
CF drawer

PCMCIAcard
front side
PCMCIAcard
front side
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First Operation of the Unitech PA966

Pressing the ON/OFF Key
The Unitech PA966 welcome screen appears. The
Windows CE® screen will appear shortly.

Adjusting Screen Brightness
Press [FUNC] key and Cursor key to decrease
or increase screen brightness.

Calibrating the PA966

The PA966 will prompt you to calibrate the unit by
tapping a sequence of screen locations. Tap gently but
firmly. When you have completed the series of taps,
press the [ENT] key to confirm it or press the [ESC]
key to cancel it.

This screen will automatically appear when the unit is
powered on for the first time or after the system is
reset. This screen can also be accessed at any time by
pressing the hot key [FUNC] and the [ESC] key.

Setting Time Zone, Date, and Time

After Calibrating the PA966, the “Date/Time Properties”
dialog box will appear. Follow the steps below to set
the date and time.

UNITECH

ۖ
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Setting the Time Zone first

Setting Year and Month

Follow the steps below to set up your time zone.

1. Tap the location arrow to see a list of cities.
2. Choose your location (or nearest listed one).
3. Select the Daylight Savings Time check box, if necessary.
4. Tap the APPLY button.

Tap the Left or Right arrows to scroll the month.

Or directly tap location of year or month to change the year or month setting.

Exiting Date/Time Properties Settings
Tap OK or X (cancel) button at upper-right corner to exit.

Tap here to
directly change
year setting

Tap here to popup
list of months



13

Product Reference Guide

Flash Memory

To save to Flash Storage, select
File, Save To, and select Flash
Storage.

Flash Memory is a re-writable location for programs and data
files. The benefit of this feature is that files and programs
saved in Flash Memory are unaffected by the PA966’s power
status.

To access the contents of Flash Memory, simply select “My
Computer” on the desktop and then select “Flash Storage”.
The programs and data files currently stored in Flash Memory
will be displayed.

ۖ
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Chapter 2. Using the Keypad and Scanner
Keypad
The PA966 series keypad contains 36 keys, including Cursor key, Numeric Key, Alpha
key, ON/OFF, Function, Escape, Backspace, and Enter key. Please refer to the picture
below.

Alpha

TO Get Press
System information Func + 9
Power Status Func + 8
Scanner Setting Func + 7
LCD Backlight on Func +
Keypad Backlight on Func +
Display Brightness – brighter Func +
Display Brightness – darker Func +

Hot Key
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When the PA966 boots, the default condition is Numeric Mode on. When you
toggle to Alpha Mode, the default condition is CAPS mode off.

Keypad Input Method

Alpha Off (Default) Alpha OnKey Pos.
FUNC Up FUNC Down FUNC Up FUNC Down

ESC ESC ESC ESC ESC
Backspace Backspace Backspace Backspace Backspace

Enter Enter Enter Enter Enter
1/F1/a 1 F1 a A
2/F2/b 2 F2 b B
3/F3/c 3 F3 c C
TAB/d TAB ` d D
4/F4/e 4 F4 e E
5/F5/f 5 F5 f F
6/F6/g 6 F6 g G
+/^/h + ^ h H

%/BL/i % Backlight i I
7/F7/j 7 F7 j J
8/F8/k 8 F8 k K
9/F9/l 9 F9 l L
-/_/m - _ m M
./;/n . ; n N

@/!/o @ ! o O
0/$/p 0 $ p P
(/)/q ( ) q Q
*/#/r * # r R

SPACE/s SPACE SPACE s S
“/’/t “ ‘ t T

,/?/u , ? u U
[/]/v [ ] v V
//\/w / \ w W
</>/x < > x X
=/&/y = & y Y
DEL/z DEL ~ z Z

ۖ
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Keying-in Characters:
After tapping the “keyboard” icon, the Windows CE keyboard pops up. Character input is
the same as on a standard PC. Simply tap the on-screen button corresponding to the
character you want to input.

Software Keyboard (Windows CE Keyboard)

Closing the Keyboard:
Tap the keyboard icon to close the Windows CE keyboard.

Moving the Keyboard:
Use the stylus to point to the title bar (the bar displaying “Input
panel”) and then move the stylus without lifting it from the
screen.

International Character Support:
Tap the [áü] button to switch from the standard English key-
board to the European keyboard.

Opening the Windows CE Keyboard:
The Windows CE keyboard can be opened by tapping the “keyboard” icon on the task bar.
(Refer to picture).

Double-tap here

Title Bar

The Windows CE provides software keypad which allows users to input
more characters.
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Using the Laser Scanner
Note: Reading software must be enabled in order to operate the scanner. This
can be a user-loaded application or a pre-loaded utility such as Scanner Setting.
exe.

The PA966 has two optional integrated scanners: Laser Scanner and Imager Scanner.

Trigger keys are located on the left and right sides of the unit. Press either one.

The PA966 also has a built-in Scanner Setting.exe program that allows the user to test
the barcode scan function for 1D & 2D also for image capturing. Scanner Setting.exe is
located in directory \Windows\Control

Scanner

ۖ
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Chapter 3. Power system

Note: Backing up data by backup battery only without the main battery installed in the
battery compartment may take as long as 6 hours. Therefore, in order to prevent data
protection failure due to backup battery failure, do not leave the PA966 without the re-
chargeable battery pack installed, or without connection to AC power for an extended
period of time.

It may take up to 72 hours to backup data when the PA966 is automatically shut
down because of very low battery power while the depleted batteries are still
installed in the battery compartment.

Note: Before using the PA966 for the first time, charge the unit for 16 hours to fully charge
the empty backup battery. Operating the PA966 for the first time without the AC adapter,
and without fully charging the backup battery may result in loss of data stored in RAM
memory.

Charging the Main and Backup Battery for the First Time

Charging the Lithium-Ion Battery Pack

The optional Docking Station is a convenient accessory for daily use of the PA966. The
charging will be completed within 3 hours. When using the included Charging
/ USB cable the charging time of the battery pack is about 3 hours.

USB Cable (P/N 1550-600623)

RS232 Cable (P/N 1550-600622)

Power Supplier (P/N 1010-600381)

Note: The power supply must work with power cord.
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“Backup Battery Very Low” icon:
When displayed indicates the backup battery is very
low. Stopping the operation and charging the PA966
immediately is highly recommended.

“Battery Very Low” icon:
When displayed indicates the battery is very low.
Stopping the operation and charging the PA966
immediately is highly recommended.

“Battery Low” icon:
When displayed indicates the battery is low and
needs to be charged. In other words, there is no
external power supply, the battery charge is low or
very low, and charging the PA966 is recommended.

Power Status Indication

Four different icons are displayed on the status bar to indicate the on-board power status.

“Backup Battery Low” icon:
When displayed indicates the backup battery is
low and needs to be charged. Backup Battery Low

“Plug” icon:
When displayed, this icon indicates that the
battery is charging. The PA966 is either plugged-
in via the DC 12V/2A power adapter or in the
docking station.

Battery Low

Backup Battery Very Low or Backup
Battery is not turned on.

No icon:
When displayed means there is no external
power supply to the PA966 but its battery power
status is good.

Battery Very Low

ۖ
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Checking Main and Backup Battery Status

Enter “Power Properties”:
If the above mentioned “Plug” icon or “Battery” icon is
displayed, double tap this icon to bring up the “Power
Properties” screen.

Or, select Settings/Control Panel from the Start
menu and then double tap the “Power” icon to display
“Power Properties”.

Check Battery Status:

It is necessary to charge the battery when “Low” or “Very Low”
are displayed in bold characters. If “Low” or “Very Low” are still
displayed after charging, please contact Unitech Technical
Support.

The battery menu item will show the status of the main and
backup batteries. There are 3 kinds of status indicators —
“Good”, “Low” and “Very Low”. Bold characters indicate the
actual status, e.g. battery icons in the illustration at right mean
both the main and backup batteries are “GOOD”.
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Tap the “Backlight” menu item to display the following 3 selections:

How to Save Battery Power

Because the power consumption of the LCD backlight is high,
turn off the backlight function if it is not necessary.
If a backlight is required, set “automatically turn off the back-
light” function.

To change backlight settings, select Settings / Control Panel
from the Start menu, and then double tap the “Display” icon.

Backlight Setting

Automatic shut-down of the PA966
The PA966 will enter idle mode when there is no task, or all tasks are waiting for input. In
default setting, the PA966 will automatically turn itself off if it remains idle for 3 minutes
and when there is no external charging power applied. Pressing the power button will
return the PA966 to the same point at the time of automatic shutdown.

This function can also be activated when the PA966 is plugged
into the power adapter or placed in its cradle by tapping the
check box and then tapping the arrow to select from a list of time
periods. The available time periods are 1, 2, 5,10, 15 and 30
minutes.

In Power Properties, select “Power Off”. Customize automatic
shut off time by tapping the arrow to select from a list of time
periods. The available time periods are 1, 2, 3, 4, and 5 minutes.

ۖ
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Warm Boot / Cold Boot

Tap the check box to toggle this function. Available idle times are: 15 and 30 seconds, and 1, 2, and 5

Automatically turn off the backlight when using battery power:

 minutes

Automatically turn off the backlight when using external
power:

Tap the check box to toggle this function. Available idle times are: 15 and 30 seconds, and 1, 2, 5, 10,
15, and 30 minutes.

Automatically turn on the backlight when key
This function is only activated by the PA966’s keypad instead of the Windows CE keyboard.

Cold Boot
Press the coldboot button underneath the PCMCIA
cover, the terminal will perform cold boot.

NOTE: Cold Boot will cause the
PA966 to return to its original
factory settings.

Warm Boot

WARNING: Warm Boot will cause unsaved data to be lost.

To perform a warm boot while the PA966 is operating, insert a pin (paper clip works well) into the
reset hole on the back of the terminal, right below the PCMCIA cover.

Under the Windows folder of your terminal, locate the file BootMode.exe, execute the program, and
confirm the warning message.
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Storage and Safety Precautions
Although charged, Lithium-Ion batteries may be left unused for several months, their
capacity may be depleted due to build up of internal resistance. If this happens they will
require recharging prior to use. Lithium-Ion batteries may be stored at temperatures
between-20°C to 60°C, however they may be depleted more rapidly at the high end of this
range. It is recommended to store batteries within normal room temperature ranges.

Charging Considerations
It is important to consider the environment temperature whenever you are charging the
Lithium-Ion battery pack. The process is most efficient at normal room temperature or
slightly cooler. It is essential that you charge batteries within the stated range of 18°C to
25°C. Charging batteries outside of the specified range could damage the batteries and
shorten their charging life cycle.

ۖ
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Chapter 4. Communication

Connecting

Introduction
The Unitech PA966 allows users to link to a host computer via USB, IrDA, or RF
connection for data communication.

This chapter provides an overview of the communication of the PA966. The following
subchapters cover these topics:

“RF Communication” for details about wireless communication between mobile PA966
and host computers.

”Microsoft ActiveSync” for details about serial communication via USB port or
Bluetooth.

Docking Station
Plug the RS232 end of the communication cable to the
PC’s 9 pin Com Port and the other end into the cradle’s
RS232 port. Plug the power supply into the powerr
eceptacle on the docking station.

Serial or USB Cable
Plug the USB end of the communication cable to the PC’s 9 pin Com Port
and the other into the PA966 USB/Charging Port (see page 3). Plug the Power
Supply into the Power Receptacle on the USB plug.

Plug in the USB end of the communication cable
to the PC's USB port and the other end into the
cradle's USB port. Plug the power supply into the
power jack of the docking station.
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ActiveSync
In order to exchange data between your desktop computer and the PA966, Microsoft
ActiveSync must be installed on your desktop computer.

This chapter will introduce Microsoft ActiveSync version 4.2. ActiveSync provides a user-
friendly interface and it can be downloaded free of charge from Microsoft’s Web site.

With Microsoft ActiveSync you can:

Add programs to and remove programs from the PA966.

Transfer data.
Back up and restore PA966 data.

Installing Microsoft ActiveSync

Before beginning installation, carefully read the following:

If you run the Windows NT® operating system with a service pack, you will be informed
during setup that you may need to reinstall the service pack. Try connecting first, and
if unsuccessful, reinstall the latest service pack.

To set up your communication settings, a PA966 serial cable is required to connect
the PA966 to your host computer.

Because you will be restarting your computer during installation, save your work and
quit all programs before you begin.

Installation
Follow the installation procedure below to install Microsoft ActiveSync, connect your
PA966 to your desktop computer, and establish a partnership for synchronization (if
desired):

ۖ



26

Product Reference Guide

Download the ActiveSync software 
from the Microsoft web site at:
http://www.microsoft.com/windowsmobile/
downloads/activesync42.mspx.
The installation wizard begins.

Click Next. You are prompt to read the
End User Licensing Agreement(EULA).

Accept the license agreement terms and
click Next. You are prompt for user information.
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Type the user's name  and organization and click Next.
You are prompted for destination folder.

 Select a drive to install the program
 and click Next.The installation wizard
 has gathered the information it needs
 to install Activesync and prompts you
 to begin the installation. 

ۖ

Click Install. The program begins
the
Installation.
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When the configuration process is
complete, you’ll see the following
screen:

Click Finish. You may be prompted to restart your computer.

After you have installed ActiveSync and restarted your computer,the ActiveSync

                                        icon appears on your computer's desktop. 

After the program has finished
installing you will see the following
screen.

Connecting the Device to Your Computer
1. After Activesync has been installed, connect the USB charging cable to the universal
connector on the bottom of your device.
2. Plug the other end of the USB charging cable into a USB port on your computer.
3. Turn the device on.
4. Activesync starts automatically and configure the USB port to work with the PA966.The
New Partnership setup wizard will automatically start.

Note: If Activesync does not start automatically, click Start > Programs > Microsoft
Activesync. If a message appears indicating that it is unable to detect a connection, click
the Cancel button and manually configure the communication settngs.
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In the displayed window, you can:

Select your PA966 to use Microsoft
ActiveSync features such
as changing synchronization options,
as described in the “Synchronization”
section.

Use this window, which is the root
window to the PA966, to copy and
move files between the PA966 and your
desktop computer, as described in the
“Synchronization” section.

Open the Explorer window by double-
clicking your device icon in the Mobile
Devices window.

5. Follow the onscreen instruction.
6. When the configuration process
    is complete, the Activesync window
    appears.

ۖ

7. Synchronization will be initialized and will take place if you have chosen to synchronize
periodically or upon connection.

Note: Your computer can create a partnership with multiple PA966s. Also, a PA966 can
create a partnership with up to two computers.
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Synchronizing with your computer

Synchronization takes place according to the options you choose while setting
upActivesync on your computer. If you accept the default (On Connect) synchronization
option in the Microsoft ActiveSync Setup Wizard, you'll be able to simply connect
Your PA966 to your desktop computer and synchronization will take place.

If you have not enabled the On Connect feature in ActiveSync, you can start
ActiveSync in either of the following ways:

On your computer, double click My computer > Mobile Devices folder.
Connect the USB cable between the computer and PA966.

Connection options

You can set remote synchronization with your computer using the following
connection options:
- USB connection
- Infrared connection
- Bluetooth connection
-WiFi connection

USB Connection
To synchronize with your computer using a USB connection:

1. Connect your device to your computer using the USB charging cable.
2. Initiate connection by tapping Start > Settings > Control Panel > PC connection.
3. Select Enable direct connections to the desktop computer using this check box.
4. Tap OK.
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Synchronization
You can synchronize information between the PA966 and your desktop computer to ensure
both computers have current information. First you’ll need to install Microsoft ActiveSync
on your desktop computer.

Synchronization takes place according to the options you chose during Microsoft
ActiveSync setup. If you accept the default (On Connect) synchronization option in the
Microsoft ActiveSync Setup Wizard, you’ll be able to simply connect your PA966 to your
desktop computer, and synchronization will take place.

If you have not enabled On Connect, start Microsoft ActiveSync in either of the following ways:

If you want to change the terminal’s default baud rate or use
IrDA to communicate with the Host PC, follow the steps below
to adjust it:

Select the baud rate from the list box.4.

Tap the Change Connection button3.

Tap the PC Connection tab.2.

Tap Start, Settings, Control Panel, Communications1.

On your desktop computer, double-click the My Computer icon and then double-click the
MobileDevices folder.

Plug the RS232 cable or USB cable between the PC and the PA966.

Execute “Repllog.exe” from the PA962’s Windows directory (if ActiveSync is setup to
sync using the IrDA port on both PC and PA966).

To turn on IrDA:
1. Click on the “Control Panel” icon on your PA966

2. Double-click the “Communication” icon

3. Click the “PC Connection” tab

4. Tap the “Change Connection” button

5. Select IrDA.

Execute “Bluetooth ActiveSync”
from the PA966’s Windows
directory .

ۖ

Infrared Connection

The infrared port allows you to synchronize
information with an infrared enabled computer. Align
the infrared port of your device with the infrared port
on the computer. This method is ideal for quickly
switching between multiple
devices since there are no cables or adapters to
change.

1. Perform the steps below on your computer:
a. Configure an infrared port on your computer
following the manufacturer's instructions.
b. Once your computer's IR port is ready, open
ActiveSync.
c. Click File > Connection Settings.

d.Check Allow connections to one
of the following and select Infrared
Port (IR) from the drop-down list.

e. Click OK.
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After you’ve synchronized, you’ll see the status message in the status bar of the Mobile
Devices windows. At any time, you can check the status. Click the Tools menu, and click
ActiveSync Status to display the ActiveSync Status window.

Synchronization may take a few minutes, as
each item to be synchronized needs to be
processed. You’ll see a message indicating
that synchronization is taking place.

Synchronization will take place according to
options you’ve chosen. To initiate synchroniza-
tion manually, click Tools, and then Synchro-
nize Now.

Files

All files you create on the PA966 are stored in a My Document/PA966 My Documents
folder (if the assigned Device Name is PA966). View those files by double-clicking the
short-cut PA966 My Documents icon on your desktop computer.

If you have enabled file synchronization, your PA966 files are automatically synchronized
on your desktop computer file folder WinCE_PC My Documents - unless a different name
was chosen for the PA966. This folder can be found in one of following locations:

During synchronization, files are copied back and forth between the PA966 and the desk-
top computer.

Windows NT:WINNT\Profiles\your user-name\Personal\WinCE_PC My Documents.

Windows 95/98: My Documents\WinCE_PC My Documents.

Bluetooth Connection
For details of bluetooth connection, please refer to the Utility Manual.

2. Perform the steps below on your device:
a. Align the IR port of your PA966 with the IR
port on your computer so that they are
unblocked and within close range.
b. Initiate connection by tapping Start >
Settings > Control Panel > PC Connection.
c. Select Enable direct connections to the
desktop computer using this check box.
d. Tap the Change Connection.
e. Select IrDA.
f. Tap OK.
g. Tap My Device > Windows > Repllog.exe

Synchronizing Information

All files created on the device are stored in PA966 > My Document folder
(if the designated device name is PA966). You can view files by double clicking the
PA966 > My Documents icon on your computer.
If you have enabled file synchronization, your PA966 files are automatically
synchronized in the My Document folder on your computer, unless a different
name was chosen for PA966.

Synchronization Options
Synchronization options can be modified, including when you synchronize and what
gets synchronized. In the Mobile Device window, click Tools > Sync Options.
For each type of information, the synchronization process can be hastened by
limiting the amount of data to be synchronized. To do this, select a service and click
the Settings button. After enabling a service, you must close and reopen the
ActiveSync.
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Installing and Removing Software

Changing Synchronization Options

Synchronization options can be modified,
including when you synchronize and what
gets synchronized. In the Mobile Device
window, click Tools, and then Sync
Options.

For each type of information, the synchro-
nization process can be
hastened by limiting the amount of data to
be synchronized. To do this, select a
service and click the Settings button.

Any program created for your PA966 can be installed as long as there is sufficient memory
or storage space.

First install the software on your desktop computer and then connect the PA966 to your
desktop computer. Some software programs provide their own setup instructions. Most
software programs use Application Manager to install and remove software on the PA966.
In the Mobile Device window, click Tools, and then click Application Manager.

After enabling a service, you must close and reopen the ActiveSync Options
dialog box before the Option button is available for that service.

Note: The PA966 only supports File synchronization.  Inbox, channels and tasks are
not supported.

Inbox, Tasks, and Channels
not supported

ۖ

Using ActiveSync to Exchange Files
You can use activesync to exchange information from your device to your computer
and vice versa. changes you made to the information on one location will not affect
the information on the other one. if you want to automatically update information on
both your device and computer, synchronize the information instead.
You can copy two types of information to your device: files and Pocket Access
Windows CE Store information.
The procedure below only applies to copying files. Refer to the ActiveSync Help on your
computer for instructions on how to copy Pocket Access Windows CE store
Information.
Note: Files created on your computer may need to be converted by ActiveSync

So that they can be viewed and edited on your device, and vice versa.

To copy files:
1. Connect your device to your
Computer.
2. In ActiveSync on your computer,
Click Explore.
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Application Manager detects the software that
is available but not yet installed on the PA966.

System software and programs added to the
PA966 at the factory are stored in FlashROM.
You cannot remove or modify this software, and
you’ll never accidentally lose FlashROM
contents.

Software programs and data files added to your
PA966 after factory installation can be stored in
RAM or Flash Memory.

InBox
Following is an overview of InBox. Step-by-Step information on how to use this program
can be found in the Help function on the PA966. To view Help, tap Start, and then Help.

Sending Mail Remotely
In addition to exchanging mail messages with your desktop computer, you can send and
receive mail from a remote mail server by setting up an e-mail account with a service
provider.

Sending and Receiving E-Mail with InBox
Use InBox to send and receive e-mail messages using any of these methods:

Send and receive messages using a wireless network card to a local area network (LAN).

Send and receive messages using a dial-up connection to a service provider or your
corporate network.

Note: You can send and receive messages with Inbox, but this function cannot be
synchronized with Outlook.

Windows Explorer opens the Mobile Device window for your device.
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Note: If you’re setting up an Internet mail account with an ISP (Internet Service Provider),
the ISP must use a POP3 mail server and an SMTP mail gateway.

For dial-up connections, you’ll require an internal PCMCIA type modem card or external
modem for the PA966. You’ll also need to set up the remote connection on the PA966
using the Connections program.

For wireless connections, you’ll require a RF card for the PA966. You’ll also need to set
up the remote connection on the PA966 via the Network setting.

The software for creating an Internet Mail connection to an ISP is pre-installed on the PA966.

Setting Up Remote Mail
You can use multiple mail services to
obtain mail. For each mail service
you will access, first set up and
name each mail service. If you will
use the same service to connect to
different mailboxes, set up and name
each mailbox connection.

In the InBox on the PA966, tap
Compose, Options, the Services
tab, and then the Add button. A
setup wizard will walk you through
the steps.

Work Remotely
Mail received via dial-up connection appears in the InBox folder on the PA966, together
with the mail you synchronize with your desktop computer. Messages received remotely
are linked to your mail server rather than to your desktop computer.

You can work online, which means that you read and respond to messages while con-
nected to the server. Messages are sent as soon as you tap Send, which saves space on
your device.

ۖ
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You can also work offline. Once you’ve downloaded new message headers or partial
messages, you can disconnect from the server and then decide which message to down-
load completely. The next time you connect, InBox automatically downloads the complete
messages you’ve marked for retrieval and sends the messages you’ve composed.

Receiving Messages

Messages received by synchronizing with your desktop computer and through remote
connections appear together in your InBox. Double-tap a message to read it.

When you connect to your Internet mail service, the InBox downloads only the first 100
lines of each new message to the InBox folder by default. No mail attachments are
downloaded. When you synchronize with your desktop computer, only the first 50 lines of
each new message remains on the mail server or your desktop computer.

You’ll need to download a full message before you can view its attachments.

You can mark the messages that you want to retrieve in their
entirety the next time you synchronize or connect to your mail
service. Select the message, tap Service, and then tap
Retrieve Full Copy. The icons in the InBox messages list give
you a visual indication of the message status.

Specify your downloading preferences when setting up the
service or selecting your synchronization options. You can
change them at any time.

To change InBox delivery options for mail synchronization: In the Mobile Devices
window on your desktop computer select your WinCE icon, click Tools, and then click
ActiveSync Options. Select Message and then click Options. (For the Options
button to be available, you must have previously enabled message synchronization.)

To change InBox delivery options for remote mail: In InBox on your PA966, tap
Service and then tap the service name. Then tap Service again and tap Properties.
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To send your message, tap File and Send. Messages are placed in your OutBox folder
on the PA966 and will be delivered to their destination in one of two ways:

Sending Messages

To compose a new message, tap the New Message button on the command bar. Enter
an e-mail address in the To field or select a name from the Address Book. All e-mail
addresses entered in the e-mail fields in Contacts appear in the Address Book.

They are transmitted to your mail server the next time you connect remotely. In
InBox, make sure the appropriate service is selected on the Service menu. Then tap
Connect.

They are transferred to the OutBox folder in Exchange or Outlook on your desktop
computer the next time you synchronize.

RF Communication
Windows CE can support TCP/IP protocol, so the user can easily connect to the Internet
by Modem or RF. The following chapter is an introduction on how to connect the PA966 to
a network via TCP/IP.

PA966 come with a built-in RF card. The driver and the utility are also built in the firmware.

RF networks look and operate similarly to Ethernet networks. The only difference is
that a radio transmission replaces the hard-wire connection between the various nodes.
This means all of your existing applications that currently operate over Ethernet will
also function utilizing WLAN without any special wireless network software. This
picture illustrates a typical network topology including the PA966 with RF.

ۖ



38

Product Reference Guide

Installing the Wireless Local Area Network (WLAN) Card

RF Card Cushion

Remove the protective backing from the sticky side of the RF Card Cushion and install the
cushion along the inside upper edge of the PCMCIA Cover as shown.
The RF Card Cushion prevents damage to the RF card antenna in case the PA966 is
accidentally dropped.

Re-attach cover to the PA966

Setting Up the Wireless Card
The PA966 is pre-loaded with connection software from Cisco.
The PA966 will automatically detect these RF cards and then
display the following screen during the first-time installation.
Please note that there are two ways to set the IP address:

Insert the RF card into the PCMCIA slot.

Attach pulling-tag to antenna.

Remove the stylus, using the screw driver in
the stylus to remove the screw, and then open
the PCMCIA compartment.

Power off the PA966.

Attach the snap-on antenna to the RF card if
required (only the Cisco card comes with a pre-
installed antenna).

PCMCIA card
front side
PCMCIA card
front side

Setting the RF Communication

1. Double tap Summit Client Utility.

2. Under “Main” tab, for Active
Profile, select “ThirdPartyConfig”.
Tap “OK”.
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Setting up RF Card pre-loaded in CF Slot of PA966

The PA966 has optional RF model which is pre-loaded with RF Card in CF slot.
The PA966 RF model will automatically display the following screen when terminal
is power on.

3. Warm Start the terminal. Once the
terminal is warm started, the RF card is
detected. You will see the RF setting
window pop up. Tap “Add New”.

4. Enter the SSID. Uncheck “The
key is provided automatically”.
Enter the network key. Tap “OK”.

5. Start to search for RF signal and RF is connected.
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Appendix A
Technical Specifications

CPU/Memory

Input/Output

Audio Output A piezoelectric buzzer with software controlled volume

Contrast adjustable by software hotkey

Display 240 x 320 transflective TFT backlight color LCD supports 256K
color with touch panel and heating system.

Dual colors (green/red) for barcode good read indicationLED Indicator

SDRAM 64MB

Flash ROM 64MB Built -in (Flash Memory Manager included)

CPU Intel X-Scale 400MHz 32 CPU. Built-in real-time clock.

Input Devices Touch screen, stylus, keypad,software keyboard,
bar code laser scanner and imager scanner.

Keypad 36 physical keys with backlight including cursor key, numeric
keypad, alpha keypad,TAB, ESC, FUNC, brightness and contrast
controls

OS and Software Programming Tools

Development Language Microsoft Embedded Visual Tool for VB and VC programming
Unitech PA966 Software Developmenet Kit

OS Microsoft Windows CE 5.0 Professional Plus
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Laser Typical Depth of Field

N e a r F a r
5 m il 2 .0 in . ( 5 . 1 c m ) 5 .2 i n . ( 1 3 .2 c m )

7 .5 m i l 1 . 7 in . ( 4 .3 c m ) 8 .0 i n . ( 2 0 .3 c m )

1 0 m il 1 . 8 in . ( 4 .6 c m ) 1 0 in . ( 2 5 .4 c m )

1 0 0 % U P C 1 . 9 in . ( 4 .8 c m ) 1 3 in . ( 3 3 c m )

2 0 m il * 2 0 in . ( 5 0 . 8 c m )

4 0 m il * 2 5 in . ( 6 3 . 5 c m )

5 5 m il * 3 0 in . ( 7 6 . 2 c m )

* D e p e n d e n t u p o n s y m b o l w id t h

Decode Zone

Laser Scan Engine

Light Source: Visible Laser Dicode(VLD) 650nm.

Scan Rate: 39+Scan/Sec

Scan angle: +53° from normal

Min. print contrast: 25% absolute dark/light reflectanceat 650nm

Power Consumption: 65mA typicle@5V

ۖ
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Barcode/Symbology

Symbology Codabar

Code 11

Code 32

Code 39

Code 39 Full ASCII

Code 93

Code 128

Delta Code

EAN-8, 13

EAN128

Interleaved 2 of 5

Label Code

MSI/Plessy

Standard 2 of 5

Toshiba

Telpen

Toshiba

UPC-A, E

Imager Scan Engine

Focal Point: 7 inches (17.8cm) from lens plate (nominal)

Working
Range

8 mil
Linear

(.020cm)

10 mil
PDF417

(.025cm)

13 mil
UPC

(.033cm)

15 mil
PDF417

(.038cm)

15 mil Data
Matrix

(.038cm)

35 mil
MaxiCode

(.089cm)

Near:
3.5 in.
(8.9cm)

3.1 in.
(7.9cm)

2.5 in.
(6.4cm)

3.5 in.
(8.9cm)

3.7 in.
(9.4cm)

2.0 in.
(5.1cm)

Far:
7.6 in.
(19.3cm)

9.0 in.
(22.9cm)

12.5 in.
(31.8cm)

11.2 in.
(28.4cm)

6.5 in.
(16.5cm)

13 in.
(33cm)

Performance
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Barcode/Symbology

Linear Codabar

Code 39

Code 128

UPC

EAN

Interleaved 2 of 5

Reduced Space Symbology

Code 93

Codablock F

Aztec

Aztec Mesas

Code 49

EAN

UCC Composite

PDF 417

MicroPDF417

MixiCode

Data Matrix

QR Code

2D

Postal Postnet

Planet Code

British Post

Canadian Post

Japanese Post

KIX Post

Viewing Angle: +40º
Ambient Light: 535 to 100,000 lux (full sunlight)
Aiming
Illumination LEDs 626nm +30nm
Green Aiming LEDs 526nm +30nm
Red Aiming LEDs 626nm +30nm
Laser Aiming 650nm +10nm

ۖ
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Power

Power Management Power consumption indicated on status bar

Backup Battery

Power Options
(Battery pack can be recharged 500 cycles or more)

External AC/DC adapter @12VDC/2A with regulator

Lithium-Ion @7.4V, 1850mAH Main Battery Pack

Active mode: 117mA (Laser Engine power on, Backlight
power on)
Active mode: 217mA (Imager Engine power on, Backlight
power on)
Heaater turn on: 230mA typical (Heater only)
Standby mode: 100mA
Suspend: 5mA

Power Consumption Using Maing Battery at At 8V 25 °C

Battery Charge 3 hours with external AC/DC adapter
3 hours with docking station

1 rechargeable 3.7V, 120mAH Ni-MH battery cell for data backup

Interface Port

PCMCIA & CF PCMCIA Type II slot & CF Type I & Type II slot accept memory,
modem, and RF card

USB/Charging Port Power charging and USB supports full duplex asynchro-
nous communications and baud rate up to 115.2K bps.

IrDA Compliant to IrDA 1.2 (SIR). Baud rate up to 115.2K bps.
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Mechanical and Environmental

Shock Multiple 4.0’ (1.2m) drops to concrete

5% to 95% RH non-condensingHumidity

Weight - PA966 454g with battery pack

1.60” (4.06cm)Depth:
Width: 3.49” (8.76cm)

Dimensions -PA966 7.28” (18.5cm)Length:

Opration: Depends on product configuration
Temperature Storage: -20°C to 60°C

IP Rating  IP 54

Pin Assignment of Charge and Communication Port
Pin Assignment Description

1 DCD

2 RXD Receive Data

3 TXD Send Data

4 DTR Data Transmit Ready

5 SG Signal Ground

6 DSR Data Set Ready

7 RTS Request to Send

8 CTS Clear to Send

9 RI Ring Indicator

10 USB 5V USB 5V

11 12V 12V Input

12 NC

13 NC

14 GDN Ground

15 UDC USB Differential Data Signal High Side

16 /UDC USB Differential Data Signal Low Side

5.91” (15.01cm)Depth:
Width: 3.49” (8.76cm)

Dimensions -PA967 7.28” (18.5cm)Length:

Weight - PA967 560g with battery pack

Laser with
BT only

Laser with
BT & RF

Imager with
BT only

Imager with
BT & RF

-20~50� 0~50� -15~~50� 0~50�

Note: RF stands for pre-loaded WiFi CF card in PA966 or PA967.

ۖ
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Docking Station

Quick charging typically takes 3 hours

AC/DC adapter @ 12 VDC/2A with regulator

Power Input 16 pin connector for charging and communication pads to main
unit

Interface 1 modem port via PC/computer, 1 USB port

Accessories List

Accessories
Car Kit
Modem Cradle
4 Slot Multi-bay
Battery Pack
Universal Power Supply
Power Cord (US)
Power Cord (EU)
Power Cord (UK)
2 Slot Battery Charger
4 Slot Battery Charger
USB Cable w/ DC in port
USB Cable (Cradle to PC)
Stylus (Standard)
Tethered Stylus (Option)
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After the OS is successfully
updated, the PA966 will auto-
matically cold-start with the new
OS.

Update and Upgrade OS
Appendix B

Update OS via Compact Flash or USB

You may choose update OS via CF or USB, select the
Bootmode in PA966 Utilities.

Insert
CompactFlash chip
into PC Card
Adapter

ۖ
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Appendix C
Troubleshooting Guide

Problem Solution

Battery needs recharging or replacement.

Ensure that battery is installed correc tly .

Adjus t " Power Properties"

Battery needs recharging.

Adjus t " Power Properties" - espec ially if peripherals are
used.

Adjus t back light of LCD or Keypad.

Replace battery pack if old(battery can be recharged
approxim ately 500 cy lces.)

"Low Backup Battery" message Charge term inal for 16 hours.

Make sure terminal is powered on.

Adjus t screen brightness.

Calibrate touch screen.

Perform a warm boot - W ARNING - Unsaved da ta w ill
be lost.

Perform a cold boot - W ARNING - Termina l w ill be
rese t to de fault se ttings and da ta w ill be  lost.

Make sure scanning application is loaded and
operational.

Run " Scanner Setting" program to modify barcode read
setting.

Bar code might be distorted and should be replaced.

Battery needs recharging or replacement.

If terminal is process ing data, attach charging cable to
ensure the battery is  not depleted.

If terminal is connected to AC power, disconnect.

Perform a warm boot - W ARNING - Unsaved da ta w ill
be lost.

Perform a cold boot - W ARNING - Termina l w ill be
rese t to de fault se ttings and da ta w ill be  lost.

Terminal does not power on.

Bar code not read.

Terminal will not shut off.

Terminal either do not respond, or
responds inaccurately to touch
screen input.

Screen is blank

Battery life is short

Terminal shuts itself down.



49

Product Reference Guide

FCC Statement
This is a FCC Part 15 Class B product.  In a domestic environment this product may
cause radio interference, in which case the user may be required to take adequate
measures.

European Conformity Statement
Declaration of Conformity with Regard to the R&TTE 1999/5/EC and EMC 89/336/EEC
directives.

This Class B Digital apparatus meets all requirements of the Canadian Interferance-Causing
Equipment Regulations.
Cet appareil numerique de la classe B respecte les exigences du Reglement sur le
material broilleur du Canada.
The device is certified to the requirements of RSS-139-1 for 2.4 GHz spread spectrum
devices.

Canadian Compliance Statement

Laser Information
The Unitech PA960 series is certified in the U.S. to conform to the requirements of DHHS/
CDRH 21CFR Subchapter J and to the requirements of IEC 825-1. Class II and Class 2
products are not considered to be hazardous. The PA960 series contains internally a
Visible Laser Diode (VLD) whose emissions do not exceed the maximum limits as set
forth in the above regulations. The scanner is designed so that there is no human access
to harmful laser light during normal operation, user maintenance or during prescribed
service operations.

The laser safety warning label required by the DHHS/IEC for the PA960 series’s optional
laser scanner module is located on the memory compartment cover, on the back of the
unit.

CAUTION - Use of controls or adjustments or performance of procedures other than those
specified herein may result in hazardous laser light. Use of optical instruments with the
scanner will increase eye hazard.  Optical instruments include binolulars, microscopes,
and magnifying glasses. This does not include eye glasses worn by the user.

ۖ
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Unitech Customer Support

America http://www.ute.com e-mail: inquiry@ute.com
http://latin.unitech-adc.com e-mail: info@latin.unitech-adc.com

UTP http://www.unitech-adc.com e-mail: aidcsales@adc.unitech.com

China http://www.ute.com.cn e-mail: unitech@ute.com.cn

EMEA http://www.unitech-europe.com e-mail: sales@unitech-europe.nl

Japan http://www.unitech-japan.co.jp e-mail: sales@unitech-japan.co.jp

Taiwan http://adc-utt.unitech.com.tw e-mail: barcode@unitech.com.tw

Head Office http://www.unitech-adc.com e-mail: marketing@adc.unitech.com.tw


